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GOVERNOR’S TECHNOLOGY OFFICE
INSPECT AND FIX POWERPOINT DOCUMENT

INTRODUCTION

Which aspects of a document need to be adjusted to ensure it is accessible to all users?
Identifying and addressing issues in a PowerPoint document using both the accessibility
checklist and the guidance in this manual will resolve most compliance problems. Ensuring the
document is accessible enhances the experience for all users.
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InsPecTING AND FixiNg A PowerPoinT Document

Aooinc A Document TiTee 1o THE DocuMenT

Documents should have titles that describe their function or the purpose of the document. It is
usually the first content that is announced by screen readers instead of the file name. To give a
title to a document complete the following steps:

1. Go to the top left of the document. Click on “File” menu.

@ AutoSave

Home Insert D

%

Check
Accessibility

Review

2. After clicking on the File menu, the options will appear. Click the “*Info” button to open the
Document Properties window.

Gh Home
D New

[ Open

Get Add-ins

Save
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3. To the right of the Info button is where the Info section is. Further right of the Info section

find the “Properties” section.

Properties ~
Size

Pages

Words

Total Editing Time

Title
Tags

Comments

47.7KB

3

156

31 Minutes
Add a title
Add a tag

Add comments

4. Below where it says Properties find where it says Title.

Properties ~
Size

Pages

Words

Total Editing Time
Tags

Comments

47.7KB

3

156

31 Minutes
Add a title

Add a tag

Add comments

5. To the right of Title select where it says, “"Add a title” click on it and an input box will
appear. Write the document’s title it can be the same or different from the filename. This
document title’s is "Non-Compliant Doc.”

Total Editing Time

Title

31 Minutes

I Mon-Compliant Du:uc|

Tags

6. Now the document has a title for the screen reader to read.

Add a tag

Page 3



Usinc Creck Accessisiity Toow anp Fixing ISSues

It crucial to ensure that documents are accessible to people with disabilities. Checking and
fixing accessibility issues in documents promotes inclusivity compliance with accessibility
standards and grants equal access of information to users. It improves readability, usability, and
navigation, benefiting all users. It will enhance user experience and facilitates understanding of
content, fostering inclusivity, diversity, and equal opportunities for all to obtain information.

How 7o Finp anp usE THE “Creck AccessiBiLITY” TooL.

The “Check Accessibility” is a tool that performs a full and thorough check for whether the
document conforms to accessibility standards. It finds any issues such as the missing use of
alternative text on images, presence of complex tables, missing document language, and hard-
to read fonts’ colors to be corrected. By following these steps, it’ll enable the checker to identify
and address the accessibility issues in the document:

FINDING THE ACCESSIBILITY CHECKER

1. Go to the top left of the document. Click on “File” tab.

D

Home Insert

Check
Accessibility

Review

2. After clicking on the File tab, you can see Microsoft Office Backstage view. Find the “Info”
button to open the Document Properties window.

(n) Home
DNew

(= Open

Get Add-ins

Save
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3. In the Info section find then select the “Check for Issues” button.

Inspect Document
<] Before publishing this file, be aware that it contains:

Check for = Document properties, document server properties, content type information
Issues ~ and author's name

=  Headers
=  Custom XML data

= Content that people with disabilities are unable to read

4. In the Check for Issues drop-down select the "Check Accessibility” option. This will open
“Accessibility Inspection Results.”

Inspect Document
&) Eefore publishing this file, be aware that it contains:
Check for =  Document properties, document server properties, content type information
Issues ~ and author's name

I I PR

Inspect Document

(=) Check the document for hidden properties
or personal information.

es are unable to read

Check Accessibility
ﬁ Check the document for content that people
with disabilities might find difficult to read.

Check Compatibility
Check for features not supported by earlier
wversions of Woard.

5. The “Accessibility Assistant” Inspection Results box will now appear on the right of the
document.

Accessibility Assistant v s

Make your document inclusive

Fix these issues for a document that can be
accessed by everyone, including the
disability community.

T . )
'-, ) Show only issues on current slide

Color and Contrast

-
Media and Illustrations
Missing alt text 16
-
Tables
-
-

Document Structure

Missing slide title 2

-
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6. In the “Inspection Results” it'll show the issues making the document non-compliant.
Select an issue to work on.

Accessibility Assistant X

Make your document inclusive

Fix these issues for a document that can be
accessed by everyone, including the
disability community.

@ ) sh Iy i lid
@ ) Show only issues on current slide

Color and Contrast

Media and lllustrations

Missing alt text

* Keep accessibility checker running while working on document. To see if there are any is-
sues that could be created by fixing document or making mistakes while fixing it. *

ANOTHER WAY TO GET TO THE ACCESSIBILITY CHECKER
1. Go to the “"Review Tab.”

File Home Insert Draw Design Transitons  Animations  Slide Show Record V\EW Help  Acrobat  Accessibility

A lg abec = 5  If
E%% A V4 & 7 “ N b EI:A K I_I () Abways L
Check Inspect  Spelling Side  Reading Akt O subtit
Accessibility without Color Titlew OrderPane  Text @ ubete
Review Color & Contrast 1 Screen Reader 1] Capti

2. In the Review tab find the Check Accessibility button then click on it.

3w @D B9 O S SHARC Website Design Outlinepptx o + Last Modified: December 6 P search

File Home Insert Draw Design Transitions  Animations  Slide Show Record Review View Help Acrobat Accessibility

=Bl Rl s om@ @000 O @26

Spelling Check Translate Language Show New  Delete Previous Next Show Compare
Accessibility - Changes ~ Comment Comments ~
Proofing Accessibili Language Activity Comments

C
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3.

4.

File Home Insert Draw Design  Transitions

o | [ | 5% At

Spelling Check Translate Language
Accessibility ~ hd

[% Check Accessibility

F2l At Text

Proofing

SchoolHealth

TITLE: Schoal Health Scoe El EEEdiI"Ig Order Pane
T [% Options: Accessibility

(7) Accessibility Help

Now you will see the “Accessibility Inspection Results” box to the right of the document.

Accessibility Assistant X

Make your document inclusive

Fix these issues for a document that can be
accessed by everyone, including the
disability community.

P . i
'\.__,' Show only issues on current slide

Color and Contrast

L
Media and lllustrations
Missing alt text 16
L
Tables
L
L

Document Structure

Missing slide title 2

"

A drop-down with options on what to check for in the document will appear. Click the
Check Accessibility button.
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Some Accessisiity Issues 1o Cover

Some of the issues that we will be covering are:

e Missing alt text: Missing alternative text on an image.
e Check reading order: The reading order needs to be top-to-bottom, left-to-right.

These are the most common issues to be found in a PowerPoint document. Going over these

common issues in this guide by inspecting and fixing the errors so that the document can
become compliant.

Fixing AccessipiLity Issue: MisSING ALT TEXT

Missing alt text is crucial for individuals who are blind or visually impaired, as screen readers
rely on alternative text, also known as alt text, to convey the meaning of images. Alt text allows
these users to understand the context and purpose of the images making the document more
accessible and inclusive. Additionally, alt text is useful in situations where the image cannot

be displayed due to technical issues or when the document is being accessed by devices with
limited visual capabilities. By providing accurate and descriptive alt text, it ensures that the
document can be understood by a wider range of users.

It helps screen and document reading tools describe images to visually impaired readers. Giving
alternative text when an image, picture or clip art does not have one or has a generated crated
one can be done in a few steps: There are two ways to give an images alternative text.

FIrRsT WAY TO GIVE AN IMAGE ALTERNATIVE TEXT

1. Right click on the image.
2. Select “View Alt Text” from the drop-down menu.

idi Group >
T3, Bringto Front >
B2, Sendto Back >

5 Lock

@ Link >

Health Care Fin ancing &
Policy
$1,15L.806119
56%

Save as Picture...

T IF‘E View Alt Text.. I
2%

ID Size and Position...
c} Format Picture...

CJ New Comment

$21872%8
%
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3. The “Alt Text” box will appear to the right of the document.

Accessibility Assistant v X
1 of 16 - Media and
e lllustrations < ?

Missing alt text

How would you describe this object and its
context to someone whao is blind or low vision?

(1-2 detailed sentences recommended)

Enter image description

G Mark as decorative

Learning tip

7. In the input text box give a description of the image. In this case write “Legislative
Approved General Funds 2014-15 Biennium” to describe the image.

Accessibility Assistant voX

1 of 4 - Media and < 5
Illustrations

Missing alt text

How would you describe this object and its
context to someone who is blind or low vision?

(1-2 detailed sentences recommended)

Legislative Approved General Funds
2014-15 Biennium|

GF Mark as decorative

Learning tip

*If an image is of no importance such as it being decorative or line(s) to divide page or re-
peating logos/images that does not need to be read, then it can be marked as decorative
instead. This will cause the screen reader to overlook the image. *
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a. Below the input text box where the description of the image is given. Select the check
box called “"Mark as decorative” to checkmark it.

Mark as decorative (D

Now the image will no longer be read or will need alternative text.

8. The rest of Alt Text box will be greyed out/inaccessible to use after check marking the
Mark as decorative check box.

SECOND WAY TO GIVE ALTERNATIVE TEXT TO AN IMAGE

By using the Accessibility Assistant Inspection Results box to the right of the document.

1. Go to the Accessibility Assistant Inspection Results.

Y
Accessibility Assistant X

Make your document inclusive

Fix these issues for a document that can be
accessed by everyone, including the
disability community.

® ) sh I lid
I ) Show only issues on current slide

Color and Contrast

Media and Illustrations

Missing alt text 16

Page 10



9. Select the error Missing alt text. It'll open the alternative text box.

Accessibility Assistant ~voooX

Make your document inclusive

Fix these issues for a document that can be
accessed by everyone, including the
disability community.

P . i
'\.__,' Show only issues on current slide

Color and Contrast

Media and Illustrations

Missing alt text

10.Enter Alternative text for the image in the input field.

Accessibility Assistant ~voooX
1 of 16 - Media and
< lllustrations < >

Missing alt text

How would you describe this object and its
context to someone who is blind or low vision?

(1-2 detailed sentences recommended)

Enter image description

G Mark as decorative

Learning tip

*If an image is of no importance such as it being decorative or line(s) to divide page or re-
peating logos/images that does not need to be read, then it can be marked as decorative
instead. This will cause the screen reader to overlook the image. *
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a. Below the input text box where the description of the image is given. Select the check
box called “"Mark as decorative” to checkmark it.

Mark as decorative

Now the image will no longer be read or will need alternative text.

Now that all the images have been given alternative text or marked as decorative the Missing
Object Description error in the Accessibility Inspection Results box will disappear. As there are
no more of this kind of error that needs to be fixed.

CHECK READING ORDER

1. Select the error Check reading order, then click on verify object order.

Accessibility Assistant v X

& 1 of 1- Document Structure

Check reading order

People who cannot view the slide will hear the
slide text, shapes, and content read back in
specific order. Verify if that order is logical.

To resolve try

@ Verify Object Order

Learning tip
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11.Rearrange the items in the Reading Order panel so that it reads logically (top-to-bottom,
left-to-right).

Reading Order +~ x Reading Order  ~ x
1 Title 1: General Funds by Divisi... 1 Title 1: General Funds by Divisi...
2 Slide Number Placeholder 3: 3 * 2 Slide Number Placeholder 3: 3
3 TextBox 2: §2,043,980,148 | 3 A Picture 2

4 TextBox 6: $2,517,969,825 4 TextBox 2: $2,043,930,148

5 & Picture 2 5 & Picture 3

6 4 Picture3 6 TextBox 6: $2,517,960,825

Document No Loncer Has AccessiBiLiTy ISSUES

In the Accessibility Inspection Results there is now a green checkmark saying “No accessibility issues found. People with
disabilities should not have difficulty reading this document.

Now this Word document is compliant with all the accessibilty issues fixed meeting ADA standards. This document will now be
accessible to everyone.
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WesAIM Contrast CHecker

Wt poes WesAIM check For?

WCAG AA requires a contrast ratio of at least 4.5:1 for normal text and 3:1 for large text.
WCAG AAA requires a contrast ratio of at least 7:1 for normal text and 4.5:1 for large text.

Web AIM Contrast Checker can check the color contrast of a document. Using it to check the
text color and the background against different sizes of text will show if the contrast passes

the required WCAG of both A and AA. It is recommended to pass AAA, when possible. If the
contrast does not meet the above requirements, changes can be made by changing and/or
adjusting the color contrast of the document’s content and background to make it easier to read
the information and comply with ADA color contrast requirements.

Using The WesAIM Contrast CHecker

Text is easier to read when there is a sufficient contrast between the page background and the
text or other elements on the page. If unsure what would be an acceptable color for a good
color contrast ratio, then changing to a darker version of the font color may help. For a more
accurate contrast choice you can use a color contrast checker. A good resource is to use Web_
AIM Contrast Checker Website Resource, an online checker to verify WCAG AA and WCAG AAA
compliancy from normal to large size text.

FOREGROUND (TExT) COLOR

1. Once the website has opened the Contrast Checker can be used.

\/\/e b A | /\/\ g services articles resources
A web accessibility in mind
- i

g Search: ( P

Q Introduction to Web Accessibility

G WebAIM Trainlné

Contrast Checker

Home > Resources > Contrast Checker

Foreground Color Background Color
[#707070 | — [#FFFFFF | [
Lightness L S Lightness

[———=] —_—

[
Contrast Ratio
permalink

Normal Text
(XYY Pass ]

The five boxing wizards jump quickly.

WCAG AAA:  Fail
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https://webaim.org/resources/contrastchecker/
https://webaim.org/resources/contrastchecker/

2.

3.

4.

Go to the document and click on the Home Tab.

Select the words/sentences with the contrast error.

Carson City, Nevada 89701 Las Vegas, Nevada 89101

If you cannot attend ttheeung you can listen to it live over the mtemell The address for the legislative websites is
http://www.leg state.nv.us. Click on the link “Live Meetings™- Listen or View.

Times NewRomr ~|10 +|A™ A" éﬁ’ é/v

B I UL A~E=E.i=. styles N

Co

Select the "More Colors.”

Times New Rorr 410 < AAY ﬁ/v [L'
B I U 2 -IB:= . i= . stles N

s : Com

| Automatic
he meeting, you can I 4

b://www _leg state.nvi  Theme Colors B
H EEEENENE

yIE: June 11,°

all items to be consid
taken out of the ordes
bd or removed from tl

||II||||||E
1}

Standard Colors :d
EEC PEEEEER

Recent Colors

More Colors...
) ORDER D Gradient >

Find the “Font Color” tool and select the arrow next to the tool. A drop-down menu will
appear with color options.
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5.

6.

The “Colors” box will appear.

X
Standard | Custom | o
Colors: Cancel
L :
.
1
Color model: | RGB z|
Red: 255 5+ New
g Green: 192 5
Blue: 0 =
le i -
Hex: #FFC000
v : Current >

Select the “"Custom Tab.”

Standard

Colors:
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7. Find where it says “Hex,” in its input box that is the hexadecimal humber of the font color
that is causing the error to the document.

Colors X
Standard | Custom oK
o
r
I¢
nl Colormodel: [RGB M
Red: X
gl :255 =al Hesy
| Green: 192
Blue: o |
IB - -
Hex: #FFC000
v : : Current

8. Copy the hexadecimal nhumber of the font color.

Hex: =FFC000

3% Cut

“—f?@ Copy

9. Once the hexadecimal number is copied go back to the Web AIM Contrast Checker
website.

10. In the Contrast Checker website find the “Foreground Color input box and copy the
hexadecimal number copied in Step 9 into the input box.”

Contrast Checker

Home > Resources > Contrast Checker

| —
Foreground Color Background Color
#0000FF #FFFFFF | [ ]
Lightness =5 Lightness
4] ¢
[ -
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https://webaim.org/resources/contrastchecker/

11. Then press the “tab” key on the keyboard. Now the text color from the document will
appear.

Foreground Color
#FFCO000 | | |

Lightness
f— |
Gl

BACKGROUND (PAGE) COLOR
If the background color of the document you are checking for color contrast is white, you can

skip checking the background color (skip to Step 18 below) as WebAIM Color Contrast Checker
defaults to white. If a background color has been applied, follow the steps below:

12. Enter page color in the search bar at the top of the word document

£ page color X

13. Then choose Page color from the drop-down menu

£  page color R
Best Action
@ Page Color T — >
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14. Then choose More Colors at the bottom

£ page color X

&

>

Z

Files

5

Actions

Find in Document

(&

ew Best Action ‘

Page Color >  Theme Colors
H EEEENEER
i

le

More Background Colors

Standard Colors
L ] EEEER

Fill Effects

Border Color

Recent Colors

“page color”
2 results |
No Color

L
More Colors...

Inspect and Fixing Word Document_Ver_2.docx N Eill Effects...
Downloads

Inspect and Fixing Word Document_Ver_2-branding.... N

of the Theme Colors drop-down menu.

@ Downloads

15. Locate the Hex field input box, and copy the Hexadecimal code in the input box.

16. Open the WebAIM Color Contrast Checker and paste the hexadecimal code you copied into
the background Hex Value input field. The color picker under the hex value will show the
background color.

Contrast Checker

Home > Resources > Contrast Checker

Foreground Background
Hex Value Hex Value
e
Color Picker # Alpha Color Picker %
I | (—
Lightness Lightness
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17. Check to see if the Contrast Checker passed the color of the document. Scroll down the
website to see if it passes WCAG standards in "Normal,” “Large” and “Graphical Objects
and User Interface Components with a minimum of AA.” If it does not go the top of the
webpage, back to Foreground Color.

Contrast Ratio

1.64:1

permalink

Normal Text

WCAG AA: Fail
WCAG AAA:  Fail

Large Text

WCAG AA: Fail
WCAG AAA:  Fail

Graphical Objects and User Interface Components
|WCAG AA: Fail I

Text Input

18. Under the hexadecimal number input box there is a tool called “Lightness.”

#FFCO000 | -
Lightness

————
[

19. In the Lightness tool there is a sliding bar tool. It is used to change the color that is in the
hexadecimal input box. It makes the color darker or lighter depending on where the slide
tool is positioned. The hexadecimal number will change depending on the position of the
slide tool.

T

#FFCO000 | |
Lightness
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20. Once you've found a contrast ratio color that has passed the WCAG's standards, the

Checker will provide you with a pass for all WCAG AA normal text, large text and graphical

objects and user interface components. It is recommended to pass AAA, whenever

possible.

Contrast Ratio

7.1:1

permalink

Normal Text

TV o) R
WCAG AAA: The five boxing wizards jump quickly.

Large Text

WCAG AA: Pass

WCAG APA: (T The five boxing wizards jump quickly.

Graphical Objects and User Interface Components

[wercan: 2D | v

[Text Input |

21. Select the new hexadecimal color from the Contrast Checker and right-click and choose
Copy from the drop-down menu.

22.

23.

24,

Foreground Color
[#705400 ' '—

Emoji

Lightnhes:

Cut

G Copy

Select the text that is hard to read

Click the font icon drop-down button

Calibri o A A Aae A

B I U~ a x x A~ &JA.

Yl Font ]

Go back to the Microsoft Word document. Then go to the Colors box to the Custom tab. If
the Colors box has been previously closed, follow the steps below to open the Colors box.
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25. When the Theme Color dialog box opens, choose the “More Colors” option.

A [E)=

. Automatic

Theme Colors
H EEEENEN

Standard Colors
HE fEEEEN

Recent Colors
|

More Colors...
|] Gradient 5

26. Be in the Custom tab of the Colors box.

Standard

Colors: Cancel

Color modek  RGB b
Red: o ]

= Mew
Green: o :
Blue: 0 == .
Hex #000000

Current
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27. Find where it says “"Hex” and paste the new hexadecimal humber from the Contrast
Checker. Then press the “Tab” button on the keyboard.

sandard |_Custom | [ ]

Colors: Cancel

Color model: | RGB ~

Red: 231 = -
Green: 230 ._:_
Blue: 230 =
=
Hex: #ETEGES

Current

28. To the right of the Hex input box there is a box with two colors. The top that says New is
the color from the contrast checker pasted in, the other is the color that is currently being
used and is causing the problem for the document.

Standard Custom

golo_rs: Cancel

[] Color model: RGB Z|
q Red: .112 =
2 Green: 84 .%
Blue: 0 é‘
Hex: 705400
Current
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29. Click on the OK button.

( Colors

n

Standard  Custom

Colors: Cancel

ll_l Color model: [RGB v
n| Red 12 |5
! Green 84 |-

Blue: 0 2

Hex: #705400

Current

30. Now the selected words/sentence with the contrast error has changed color to the one
from the contrast checker and meets ADA Color Contrast requirements.

If you cannot attend thq meeting, you can listen to it live over the internet. [The address for the legislative websites is
http./7Www.leg state.nv.us. 1ve Meetings™- Listen or View.

31. Now there are no more Hard-to-Read Text Contrast errors. The error has now disappeared
from the Accessibility Inspection Results.

STATE OF NEVADA

GOVERNOR'S TECHNOLOGY OFFICE
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